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ApexSQL® Analyze 2022.x 

Release Notes 

These release notes provide information about the ApexSQL® Analyze 2022.x which is a minor release. 

Topics: 

● About ApexSQL Analyze 

● New features 

● Getting Started 

● System requirements 

● Supported platforms 

● Product licensing 

● Release History 

● About us 

About ApexSQL Analyze 

ApexSQL Analyze analyzes graphical SQL Server database object dependencies and the impact of potential 

deletions on your SQL database. It determines object interrelationships within the database and allows 

dependency diagrams appearance customization. 

New Features 

This version of ApexSQL Analyze introduces the following new features, enhancements or deprecations: 

 

Fixes: 
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 211654: "Could not load file or assembly 'Microsoft.Identity.Client'" error is encountered when trying 

to connect to the Azure server with Active Directory - Universal with MFA type of authentication 

 211716: Couldn't connect to the targeted database in the case when using Azure Active Directory - 

Password authentication type while database name is typed in connection controls 

 211717: Couldn't connect to the targeted database in the case when using Azure Active Directory - 

Integrated authentication type while database name is typed in connection controls 

Changes: 

 The activation model is switched to Subscription 

 The application does not support integration into SQL Server Management Studio 2012, 2014, and 

2016 versions 

 The application does not support integration into Visual Studio 2010, 2012, 2013, and 2015 versions 

Known issues: 

 "The 'ApexSOLAnalyzeJnstPackage' package did not load correctly" error is encountered when the 

Visual Studio 2019 16.7 version is started 

 "Failed to authenticate the user in Active Directory (Authentication=ActiveDirectoryInteractive). Error 

code 0xno_client_id No ClientId was specified." Error is encountered when the Show dependencies 

feature is initiated and the user is connected to a remote server using Azure Active Directory - 

Universal with MFA authentication 

 

Getting Started 

 For further information about installation and getting started, please check the Quest Knowledge Base or 

ApexSQL Getting Started. 

System requirements 

Before installing or upgrading Short Product Name Version, ensure that your system meets the following minimum 

hardware and software requirements.  

System requirements 

 

https://knowledgebase.apexsql.com/apexsql-for-mysql-tools-licensing-and-renewals/
https://support.quest.com/apexsql-complete/kb
https://www.apexsql.com/getting_started.aspx
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Hardware Dual Core 2.0 GHz CPU 

4 GB memory 

112 MB disk space 

SQL Server SQL Server 2005 and higher [1] 

Azure SQL Database [1] 

Amazon RDS for SQL Server [1] 

Add-in integration SQL Server Management Studio 2012 and higher [2] 

Visual Studio 2010 and higher [1] 

OS Windows 7 SP1/Windows Server 2008 R2 SP1 and higher [1] 

Software .NET Framework 4.7.2 or higher 

Permissions and 

additional requirements 

Windows user account with administrative privileges 

See Minimum permissions required to install and use ApexSQL products 

See Minimum SQL Server permissions for ApexSQL Developer tools 

See Remote access for SQL Server instance 

[1] See Supported systems for exact version support 

[2] You can use the latest full-featured backwards compatible SQL Server Management Studio for free. Click here 

Supported platforms 

 

Windows version 

Windows 7 SP1 & 

Windows Server 2008 

R2 SP1 

Windows Server 2012 

Windows 8.1 & 

Windows Server 2012 

R2 

Windows 10 & 

Windows Server 2016 

Windows Server 

2019 

https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimal-sql-server-permissions-apexsql-developer-tools/
https://knowledgebase.apexsql.com/configure-remote-access-connect-remote-sql-server-instance-apexsql-tools/
https://prelive.apexsql.com/supported-software.aspx
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
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SQL Server version [3] 

 2005 2008 2012 2014 2016 

2017 2019 CTP 3 

Windows Linux [2] Windows Linux [2] 

ApexSQL 

Analyze  

         

 

 

SQL Server edition [3] 

 Express Standard Enterprise 

Azure SQL Database 

Amazon RDS for 

SQL Server Single Database,  

Elastic Pool 

Managed 

Instance 

ApexSQL 

Analyze  

      

 

Visual Studio add-in integration 

 2010 2012 2013 2015 2017 2019  

ApexSQL 

Analyze  

      

 

 

SQL Server Management Studio add-in integration 

https://www.apexsql.com/sql-tools-analyze.aspx
https://www.apexsql.com/sql-tools-analyze.aspx
https://www.apexsql.com/sql-tools-analyze.aspx
https://www.apexsql.com/sql-tools-analyze.aspx
https://prelive.apexsql.com/sql-tools-analyze.aspx
https://prelive.apexsql.com/sql-tools-analyze.aspx
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 2012 2014 2016 17 18  

ApexSQL 

Analyze  

     

 

 [2] Tested on Ubuntu 16.04 

[3] Including Amazon EC2, Google Compute Engine, and Azure Virtual Machine cloud computing SQL Server 

instances 

 

Release History (release notes) 

Release: 2022.01.0222 

Date:  May 12, 2022 

Fixes: 

 211654: "Could not load file or assembly 'Microsoft.Identity.Client'" error is encountered when trying to connect 

to the Azure server with Active Directory - Universal with MFA type of authentication 

 211716: Couldn't connect to the targeted database in the case when using Azure Active Directory - Password 

authentication type while database name is typed in connection controls 

 211717: Couldn't connect to the targeted database in the case when using Azure Active Directory - Integrated 

authentication type while database name is typed in connection controls 

Changes: 

 The activation model is switched to Subscription 

 The application does not support integration into SQL Server Management Studio 2012, 2014, and 2016 versions 

 The application does not support integration into Visual Studio 2010, 2012, 2013, and 2015 versions 

Known issues: 

 "The 'ApexSOLAnalyzeJnstPackage' package did not load correctly" error is encountered when the Visual Studio 

2019 16.7 version is started 

 "Failed to authenticate the user in Active Directory (Authentication=ActiveDirectoryInteractive). Error code 

0xno_client_id No ClientId was specified." Error is encountered when the Show dependencies feature is initiated 

and the user is connected to a remote server using Azure Active Directory - Universal with MFA authentication 

 

Release: 2020.02.0210 

Date:  April 14, 2021 

Fixes: 

https://prelive.apexsql.com/sql-tools-analyze.aspx
https://prelive.apexsql.com/sql-tools-analyze.aspx
https://www.apexsql.com/sql_tools_readme.aspx?Product=Complete
https://knowledgebase.apexsql.com/apexsql-for-mysql-tools-licensing-and-renewals/
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 205740: "Database '%database name%' not accessible for the user '%username%'" error is encountered 

when trying to Link database using ApexSQL Source Control when ApexSQL Analyze is integrated into 

SQL Server Management Studio 

 192415: "Object reference not set to an instance of an object" error is encountered when query execution 

is canceled due to endless running time in SQL Server Management Studio 18 when the ApexSQL 

Analyze is integrated into it 

 205741: "Unable to create data instance" error is encountered when "One click documentation" is used 

for ApexSQL Doc when ApexSQL Analyze is integrated into SQL Server Management Studio 

 204596: "A connection was successfully established with the server but then an error occurred during the 

pre-login handshake provider HTTP, error: 0 -)" error is encountered when trying to connect on the SQL 

Server which has Force Encryption option enabled 

Changes: 

 "Trust server certificate" option is added under the Connection options dialog 

 

Release: 2020.01.0190 

Date:  August 24, 2020 

Enhancements: 

 Application telemetry now collects anonymous data on the use and performance of applications and 

application components 

 ApexSQL Updater is added for configuring advanced updating settings of all installed ApexSQL products 

Fixes: 

 "Loading objects and dependencies failed" error is encountered when loading a database with objects 

that reference synonyms for tables or views 

Changes: 

 Error handling and send logs functionality has been modified 

 

Release: 2019.02.0163 

Date:  December 19, 2019 

Enhancements: 

 SQL Server 2019 support 

Fixes: 

 Depending columns for SQL view objects are not show in the Dependencies panel 

https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
https://knowledgebase.apexsql.com/how-to-auto-update-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/send-logs-feature-in-apexsql-tools/
https://blog.apexsql.com/sql-server-2019-ga-support-for-apexsql-products/
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 ”Login failed for user” error is encountered when using the Active Directory - Integrated authentication in 

SQL Server Management Studio and when the Show dependencies command is initiated from the right-

click context menu in Object Explorer 

 SQL Server Management Studio stops working when the Show dependencies command is selected from 

the right-click menu in Object Explorer on a database without required permissions 

 

Release: 2019.01.0129 

Date:  July 15, 2019 

Enhancements: 

 SQL Server Management Studio integration support 

 Visual Studio integration support 

 Show column dependencies option is added under the View tab 

 Diagrams can be exported as DOCX, PDF and XML 

 EMF file fomat is added when diagram is exported as an image 

 Print option is added under the Home tab 

 Object style customization is added under the Options window 

 External database analysis option is added in the project options under the External databases tab 

 Update all objects from the schema option is added under the Home tab 

 Show/hide constraints option is added under the View tab 

 Include system objects option is added under the General tab in the Options window 

 Show dependencies for the snapshot option is added in the project options 

 Project options window is added for creating a new project 

Fixes: 

 Different values for constraints are shown in the Object browser of ApexSQL Analyze and in SQL Server 

Management Studio’s Object Explorer 

 Saved project file can’t be opened with a double-click on it 

 Toggling user type items on and off in the analyzed diagram displays inconsistent behavior when a 

related schema with the same name exists 

Changes: 

 The application has been split into three editions - Azure, Standard and Professional 

 Diagram now allows customization of dependency depth 

 

 

 

 

https://blog.apexsql.com/sql-server-management-studio-ssms-18-support-for-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-studio-2019-preview-support-for-apexsql-tools-add-ins/
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About us 

Quest creates software solutions that make the benefits of new technology real in an increasingly complex IT 

landscape. From database and systems management, to Active Directory and Office 365 management, and cyber 

security resilience, Quest helps customers solve their next IT challenge now. Around the globe, more than 130,000 

companies and 95% of the Fortune 500 count on Quest to deliver proactive management and monitoring for the 

next enterprise initiative, find the next solution for complex Microsoft challenges and stay ahead of the next threat. 

Quest Software. Where next meets now. For more information, visit www.quest.com. 

 

Contacting Quest 

For sales or other inquiries, visit www.quest.com/contact 

Technical Support Resources 

Technical support is available to Quest customers with a valid maintenance contract and customers who have trial 

versions. You can access the Quest Support Portal at https://support.quest.com. 

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a 

day, 365 days a year. The Support Portal enables you to: 

● Submit and manage a Service Request 

● View Knowledge Base articles 

● Sign up for product notifications 

● Download software and technical documentation 

● View how-to-videos 

● Engage in community discussions 

● Chat with support engineers online 

● View services to assist you with your product. 

 

 

  

https://www.quest.com/
http://www.quest.com/contact
https://support.quest.com/
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© 2022 Quest Software Inc. 

ALL RIGHTS RESERVED. 

This guide contains proprietary information protected by copyright. The software described in this guide is furnished under a 
software license or nondisclosure agreement. This software may be used or copied only in accordance with the terms of the 
applicable agreement. No part of this guide may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and recording for any purpose other than the purchaser’s personal use without the written 
permission of Quest Software Inc. 

The information in this document is provided in connection with Quest Software products. No license, express or implied, by 
estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Quest 
Software products. EXCEPT AS SET FORTH IN THE TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR 
THIS PRODUCT, QUEST SOFTWARE ASSUMES NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED OR 
STATUTORY WARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT SHALL QUEST SOFTWARE 
BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF INFORMATION) ARISING 
OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF QUEST SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. Quest Software makes no representations or warranties with respect to the accuracy or completeness of 
the contents of this document and reserves the right to make changes to specifications and product descriptions at any time 
without notice. Quest Software does not make any commitment to update the information contained in this document. 

If you have any questions regarding your potential use of this material, contact: 

Quest Software Inc. 

Attn: LEGAL Dept 

4 Polaris Way 

Aliso Viejo, CA 92656 

Refer to our Web site (https://www.quest.com) for regional and international office information. 

Patents 

Quest Software is proud of our advanced technology.  Patents and pending patents may apply to this product. For the most 
current information about applicable patents for this product, please visit our website at https://www.quest.com/legal.  

Trademarks 

Quest, the Quest logo, and Join the Innovation are trademarks and registered trademarks of Quest Software Inc. For a complete 
list of Quest marks, visit https://www.quest.com/legal/trademark-information.aspx.  All other trademarks and registered 
trademarks are property of their respective owners. 

Legend 

 CAUTION: A CAUTION icon indicates potential damage to hardware or loss of data if instructions are not followed. 

 

  IMPORTANT, NOTE, TIP, MOBILE, or VIDEO: An information icon indicates supporting information.  

 

https://www.quest.com/
https://www.quest.com/legal
https://www.quest.com/legal/trademark-information.aspx

